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Section 1: INTRODUCTION
These two pieces of equipment are very in‐depth, complication pieces of technology. The Sokkia
650rx reflectorless total mapping station (TMS) is a tripod machine used in construction, conservation,
mapping and other field work occupations. To be very simple, it uses a laser to shoot a beam at an
object and by doing so records data such as distances, angles and coordinates to the memory. The
Carlson Mini‐computer uses the SurvCE software that can take data from a TMS and use it to find and do
many calculations and to make a small map of an area you have used the TMS on. Many processes
useful to students and faculty can be carried out simply on one of them but with the connection you
have between both items the amount you can do is fascinating and is much too long to be described in
this manual.
Before you even start thinking about using these tools it is essential that an employer, professor,
advisor, or whoever the machine belongs to teach the proper way of simply picking them up and/or
putting them down and other handling concerns initially. They are very expensive and it’s critical that
each item be used, cleaned, charged and put away properly into whatever carrying equipment being
utilized for optimal efficiency. This guide does not go into detail on the software, tools, and dynamics of
each piece of equipment. It is assumed that the manuals have been read or critical sections scanned, at
least to gain knowledge of screen basics and operating basics. The ability to connect these two pieces of
equipment offers students and faculty the ability to instantly save field data on two machines, not have
to be restricted to a cord length and put data from the field into software that manipulates and
augments it without having to stop the process of taking measurements.

ATTENTION
For convenience of the reader; please note that whenever quotation marks surround a bold word or
abbreviation it indicates a screen title, word, button or abbreviation on the screen or the keyboard of
the Total Mapping Station. If you see quoted, bold expressions pay extra close attention to the screen
and keyboard and do not go too fast. The “ENTER” button referred to in the Sokkia section of this
report is not labeled on the device but is the biggest button on the keypad and looks similar to a back
arrow and is just to the left of the direction pad on the TMS keyboard.
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Section 2: BLUETOOTH CONNECTION SET UP – SOKKIA TMS

2.1: Device On and Orientation
The Sokkia TMS has many configurations and settings that allow the user to connect and
interact with many forms of technology. In the past, it has generally been via a cable or some type of
removable media storage such as a flash drive or MicroSD card. This machine still has that capability but
utilizing the Bluetooth function allows for instant storage and instant data manipulation.
The first thing to do, assuming the TMS was charged, set up, and correctly leveled is to configure
the machine to your “JOB”. The machine stores and separates your work area into jobs. Each job can
save its own settings and configuration so one will not have to change settings every time you switch to
a new job, it will do it for you. Many jobs have their own parameters and sometimes changing the
settings can be a crucial part of data gathering and analysis.
When you turn the machine on you will be in the measuring menu for convenience of the user.
At this point hit the button that says “ESC” in the lower left meaning escape. This brings you to the main
menu where you will see “Sokkia” displayed and four option menus on the bottom of the screen saying
(from left to right) “MEAS” meaning measure, “MEDIA” being attachable media, “MEM” being memory
and “CNFG” for configuration. Push the button that says “MEM”.
As I said in the introduction, this manual will not go into all the configurations and tools that can
be changed from job to job but a general overview to get the Bluetooth connected so one can start
learning how to manipulate their data and learn the more advanced software functions.

2.2: Job/Data Selection
Once the “MEM” button is pushed, a heading saying “Memory” with a list of options starting
with “JOB”, “Known Data”, “Code” and “Dialup” will appear. Highlight “JOB” press “ENTER” and a “JOB”
menu will appear. Select “JOB selection” that will then be the heading in the top left of the screen, then
arrow left or right to your intended job and click the “ENTER” button. If you want a new job find the
closest, clean file/job and hit “ENTER”.
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The lower part of this screen asks you what data you want to use, if you have data already
stored and ready, arrow left or right it and hit “ENTER” again or hit “LIST” in the lower left of the screen
and scroll down or up until you have your data. If you want a clean file for a new job select the file that
corresponds to the job you’re on and hit the “ENTER” button, odds are if you haven’t used that job you
haven’t used its file for storage. Hit the “ENTER” button and it should bring you back to the “JOB”
screen. To make sure you have either your new, clean file for the new job or the data you were looking
for hit “ESC” once to back out the “Memory” menu.
Once here arrow down one click to the “Known data” menu and hit “ENTER”. Here it will say
“Known data” and just under that it should say your job number or name, if you named it. Arrow down
to “View” and hit “ENTER”. Click “ENTER” on any point to confirm if that is the data file you want, if it is
or is not go back to the “JOB Selection” by pressing “ESC” three times. This will return you to the
“Memory” menu. Select “JOB” and hit “ENTER” and find the right job and data by repeating the job
selection process above.

2.3: Bluetooth Information on TMS
Once your data and job are selected you should be back at the “JOB” screen. You’ll notice five
options to select from top to bottom are “JOB selection”, “JOB name edit”, “JOB deletion”, “Comms
output”, and “Comms setup”. To get the TMS to follow Bluetooth we need to select “Comms setup”.
When you click on that the TMS will bring you to a screen with four options, and from top to bottom are
“Wireless”, “Bluetooth setup”, “Link device list”, and “My device info”.
The first things you want to do is set the “Wireless” option to “Yes”, then select the “Link device
list” option. Find a spot to name and register your companion device by highlighting a device slot and
pushing the “F1” button shown on the screen as “EDIT”. You will be at a screen called “Device
registration” where you create a name for the device and then hit “ENTER”. When you hit enter you will
be on the lower part of the screen where it’s labeled “BD_ADDR:” which stands for Bluetooth device
address. You should notice the “F1” button is now shown as “INQ” on the screen and will search for
devices to connect to. Click the “F1” button to start the inquiry process. It will bring up a list of
connectable Bluetooth devices in the area, make sure you know your Carlson device address, highlight
the right address and hit the “F4” corresponding to “OK” on the screen.
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You will be back at the “Device registration” screen where you will see the address of the device
highlighted and hitting the “REG” button which is the “F4” button on the keyboard will select the
Carlson Mini as your companion device. Once the device is registered the TMS is basically ready to sync
up but hit “ESC” and enter the “Bluetooth setup” screen and set the TMS to “Slave” as the Carlson is the
master device.
You will not need a passkey so leave that and Leave “Authentication” at no and “Check sum” at
no. “ESC” four times until you get back to the main menu which is the screen with “Sokkia” displayed
and the 4 options from left to right “MEAS”, “MEDIA”, “MEM”, and “CNFG”. This device is now ready for
connection to the Carlson Mini Handheld.

Section 3: BLUETOOTH CONNECTION SET UP – CARLSON

3.1: Device On
Start by turning it on with the power button in the lower right. Hit the “start” button just like an
everyday computer. The second option from the bottom is “settings”, click on it. It will bring you to a
screen that says “settings” in the top left. On the bottom there are 3 tabs, click on the last one that says
“connections”. In the middle of the top row of icons is the “Bluetooth” symbol, click on it.

3.2: Adding a Device
If your device has not been added, add it to the menu now. Click “add new device” and wait for
the Carlson to find the Sokkia TMS, click on it once it appears. At the bottom of the screen is the word
“Next”, click on it. It will then prompt you for a passcode disregard this and hit “Next” on the bottom.
The TMS should make a beep at this time and the Carlson will ask if you want to connect to the Sokkia
TMS, select the “yes” option. It will again bring you to a passcode screen; simply hit the cancel button on
the bottom of the screen.
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Once added you should notice 3 tabs at the bottom again. Click on the “mode” tab and make
the device visible to other Bluetooth using devices and the area and refresh the menu. Once completed
select the tab labeled “COM ports”. Set up the port selecting “New Outgoing Port”. Select the Sokkia
TMS as the device you wish to add and hit “Next” on the bottom.
You will be at a screen that says “Bluetooth” at the top. Under this it says “Port:” then has a field
to select a com port and if checked uncheck the box that is labeled “Secure Connection”. By selecting
the down arrow and tapping on any one of the ports it will be set up to transfer using that specific port
for this specific Sokkia TMS. Be sure to remember which port it is. Click the “Finish” button at the
bottom.

3.3: Selecting Data in SurvCE
The next step is to open up SurvCE, the software that utilizes the mapping tools and other GIS
programs. Click “start” once again and in the upper half of the options is the label and icon for SurvCE
which is a little picture of Earth wearing a hardhat, click it. When it opens the software it wants to know
if you want to continue the last job being worked on, load another saved job or start a whole new one.
Choose either one. If you choose to continue the last job it will bring you straight to the SurvCE main
page. However this example is made to use a new job. It assumes you have not yet started any jobs on
the Carlson.

3.4: New Job/Data
If you want to load data move to the next paragraph. If you start a new job a prompt will appear
that is labeled “Coordinate Files” which stores coordinate data. Create a name for the file by clicking on
the field at the bottom that says “Name”. Click the green checkmark at the top to confirm and click on
the green checkmark at the top of the “Coordinate Files” screen as well. “QQQ:” will appear which is
simply asking what the name of this job is going to be saved as. Create a name and hit the green
checkmark again for the name then once again to advance to the next screen.
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3.5: Loading a Job/Data
If you want to load a file it will bring you to a load file screen where you can select the job you
want to continue on. Highlight the coordinate file you want and hit the green checkmark at the top of
the screen. When you get through naming and declaring a file destination you will be at the “Job
Settings” page, here you can just select the green checkmark at the top as the settings have been
modified to adjust to the Sokkia station.
3.6: Enter of Points Manually
The next screen will be labeled “Enter Point Coordinates” which is prompting you to enter
known points. However you can just click the red “X” on this one because we will be transferring points
from the TMS not entering them. You should now finally be at the SurveCE home page where there are
5 tabs at the top. Click on the tab that says “Equip” and under that tab click on the first option that reads
“Total Station”.

3.7: Selecting the Sokkia Total Mapping Station
There are now 3 more tabs at the top that are labeled “current”, “comms”, and “settings”.
Under the “current” tab you should see a box that says “Manufacturer”. Scroll through it and find the
“Sokkia” option and select it. Now click the “comms” tab and make sure the type is “Bluetooth”, the
device is “windows mobile” and the instrument is the “set650rx”. Under the “settings” tab you can
change either one of those options and it won’t matter for what this guide is for. Now if you go back to
the “current” tab and hit “save” down at the bottom it will save this TMS configuration so you can use it
on another job. Now hit the green check mark at the top and you should be completely linked to the
Sokkia Set650rx Total Mapping Station with the Carlson Handheld GIS Mini Computer when it says
“Bonding with Bluetooth”.
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Section 4: FILE TRANSFER EXAMPLE

4.1: Job and Transfer Type
In order for you to follow this next portion of the guide there must be some data you can
transfer from the TMS. Select the job and data you want on the TMS and set the machine up to be ready
to use Bluetooth with the Carlson. Go to the main menu of the TMS and select the “MEM” button.
Then in the “Memory” menu select the “JOB” option. Arrow down to “Comms output” and
select it. You should now be at a list of the jobs on the left and how many files or points associated with
the job on the right. Arrow down to the job you wish to transfer data from and hit “ENTER” once. You
should notice where the number of files was it now says “Out” meaning transferring out. Hit “OK” which
is the”F4” button and it should come to a screen that is labeled “Comms output” with 3 options below it
reading “SDR33” and “SDR2x” and “Printed output”. For this example and these devices the “SDR33”
will be utilized so click on it. Once selected, 2 more options will appear labeled as “Obs data” and
“Reduced data”, at this point STOP! Do not go any further on this machine; the Carlson now has to be
ready to receive the data.

4.2: Port Check and SurvCE Interface
Before you go any further remember which port you set up for connection on the Carlson
because you will need to utilize that port for transfer. On the Carlson Mini select the SurvCE software
and select a new job. Name it and select your coordinate file and when it prompts you for known
settings just click the green checkmark. When it prompts you for points hit the red “X” in the upper
right. This example will transfer the known points of the TMS to your data on the Carlson so you will not
have to enter all the points.
Once you’re at the main page of the SurvCE software with the 5 tabs reading “Survey”, “COGO”,
“Road”, “File”, and “Equip” make sure you are on the tab labeled “File”. Under the “File” tab is a list of
sub‐options. You should notice that sub‐option 6 is labeled “Data Transfer” with a little green icon next
to it. Click on this option.
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4.3: Data Transfer
It will bring you to a “Data Transfer” screen, labeled at the top left, with many options of data
transfer and storage abilities. At the bottom is a field labeled “Com Port”. Make sure you select the Com
port associated with the Sokkia TMS you set up earlier. Three lines down you should notice two options
labeled “Kermit Transfer” and “SDR Transfer”. Select the “SDR Transfer” option. A screen with two
options and two interactive fields appears. The options should read “Send File” and “Receive File” while
the interactive fields read “Baud Rate” and “Parity”. Set the “Baud Rate” to 9600 and leave “Parity” at
none for this example.
This next step is the file transfer process and should be done rather quickly because if too much
time passes between the setting of both machines the transfer will time out and will need to be
restarted. Now Have both devices in front of you or have one person with one and another with the
other. On the Sokkia TMS select the “Obs data” option and it should say “waiting for connection” and
go through a thinking process now you or your partner select the “Receive File” on the Carlson after
that. The TMS should start transferring and the Carlson will read “Receiving Lines”.
Wait until the whole process is complete on both machines. The Sokkia will go back to the
screen with the jobs on the left and associated files on the right. The Carlson will bring you to a screen
called “CRD File to Import To” Select the job you wish to transfer the points to by highlighting it and hit
the green checkmark in the top.
To check to see if the data made it to the Carlson, go the “File” tab in the main screen of the
SurvCE software on the Carlson and select sub‐option 3, “Points”. A list of the points from the TMS
should now be in this raw data chart for manipulation.
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Section 5: EXPORTING ASCII SurvCE FILE FOR RAW DATA EXCEL FILE

5.1: Having Data on Carlson Handheld
The first thing to do for this section is make sure you have data transferred from the TMS to the
Carlson that you wish to make alterations to. To check go into the SurvCE software on the Carlson, load
a job and click on the subheading called “Points” under the “File” tab under the main screen. Look at
your points and confirm they are the ones you intend to use in an Excel File.

5.2: Connecting Carlson to the Computer via USB
In the packaging that the Carlson handheld came in there should be a USB cable that attaches to
any standard USB port on a computer and the other end connects to the most left hand port at the
bottom of the Carlson. Plug the two ends in a wait for a screen that says “Windows Mobile” on it. If this
is your first time plugging the Carlson in this way it will ask to install “Windows Mobile” if not previously
done so with other mobile devices. Install the program if prompted and once at the main screen you’ll
have four options to choose from being “Programs and Services”, “Pictures, Music and Video”, “File
Management” and “Mobile Device Settings”. Select the option that says “Mobile Device Settings”.

5.3: Windows Mobile Set Up
Once selected a drop down menu appears. Select the first option that reads “Change content
sync settings”. At the bottom is a picture of a file that reads “Files”. To the left of the picture is a check
box that you can check and uncheck. Make sure this is checked and click the save button. You will be
back at the main “Windows Mobile” screen and from here select the “File Management” option where
another drop down menu will appear. Select the first option which says “Browse the contents of your
device”. It should open up the contents of your computer and have a couple different files of what is on
the handheld. Click the file for “Storage”. Once here stop and wait, because you will now send a file
from the Carlson to this “Storage” file to make into an Excel file.
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5.4: Exporting an ASCII File
Go back to the Carlson. You should still be in the right job with the right data set up from section
5.1. Click the subheading that says “Import/Export” under the “File” tab in the main menu of the SurvCE
software. At the top of the screen it should say “Export Ascii”. Do not change where it says “File Type”.
Set up your “Coordinate Order” (orders the way your data is presented) to your liking and make sure
your “Delimiter” is set to “Coors” and for “Commas”. This will separate your coordinates and your
coordinate information will be separated by commas so it can be easily transformed into Excel file cells.
The “Range” should automatically adjust to how many points you have in the job. If this does not
happen make sure you are in the right job again. Once all this is confirmed select the green check mark
at the top.
The next page should read “Ascii File to Write” meaning what the name of the file will be that is
going into the computer. Name it whatever you please and make sure it saves as “.txt” file, which it does
automatically. Select the green check mark at the top and the file will export to the computer quite
quickly. The Carlson should send a small message that reads “SurvCE done”.

5.5: Converting ASCII to Excel File
Once the ASCII file has been sent go back to your laptop or desktop computer where instruction
ended in section 5.3. Hit the refresh button and find your file you just exported. It will have the name of
the “.txt” you named it and be labeled as a “Text Document” that is opened up with the program
Notepad. Double click the file and Notepad should open it. Confirm this is the data you need/want and
close Notepad and either if it is not the correct data go back to the Carlson and export the correct data.
Save this file onto the “desktop” or into your “documents” section for ease of use. Excel has an easier
time opening the file from the desktop or out of your documents rather than out of the “Storage” folder
on the Carlson.
Next, open up Microsoft Excel. In the upper left are the options “File, Home, View” etc. Click on the
option that reads “Data”. This allows you to work with data you have already entered or put into files.
While still under the “Data” tab again in the very top left it says “File”, do not click it but underneath
should read three options to get data from different resources. Select the third option says “From Text”.
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Find the “.txt” file in your desktop or in your documents and double click or click once and hit import at
the bottom of the window.
Another window comes up labeled “Text Import Wizard Step 1 of 3”. The first step you can usually
select “Next” at the bottom on because you want to keep the data delimited so you can separate the
data at the commas in the next step. The next step asks where you want to create columns at. Deselect
the “tab” box and select the “comma” box. This will now separate each column where, in the original
text, a comma was. You do not need to hit “Next” so simply hit “Finish” at the bottom and the data will
automatically be put into Excel organized by row and column to be manipulated, further organized or
sent to somebody who needs it. Just make sure to save your work.
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